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1 INTRODUCTION

1 Introduction

1.1 What is Client Manager?

Every speech professional knows how important it is to keep track of client
progress. With accurate progress reports, it is easier to tailor treatment to
a client’s changing needs. We also know how hard it is to keep track of so
many print-outs, handwritten notes, paper tests, and homework papers. Even
if you take the time to record everything in one place, you can never record
everything you might someday need to know.

Enter Client Manager, from LocuTour Multimedia. With Client Manager
you can easily keep track of all of your clients’ sessions. Client Manager will
track the use of Client Manager-enabled software—including most LocuTour
Multimedia products—as well as sessions that do not involve computer-based
exercises. You can generate charts of client progress and print out progress
reports to keep as records, give to clients and parents, use in IEPs, and submit
to insurance companies. Client Manager remembers results from every session
and every game played by each client, and provides you with an easy interface
for looking up stored information. Client Manager handles the paperwork so
you can spend more time with your clients.

1.2 What does Client Manager do?

Client Manager provides a framework for tracking client progress. It is espe-
cially useful for tracking progress for clients using Client Manager-enabled
software. Its job is to track your clients’ progress over time, and present this
information in three formats: graphs, SOAP-format progress reports, and
services summaries.

First you create a profile for each client. It will contain a complete record
of all the Client Manager-enabled games the client plays. You can also enter
information on sessions where no computer-based games were played. When
you finish a Client Manager enabled game the program will remember data
related to the game. It will record the time it took to complete a level, the
number of mistakes made during a game, the number and type of speech
productions, other game-specific information, and clinician notes.

You can use the stored information to generate graphs that clearly document
progress from session-to-session, week-to-week, or month-to-month. You can
customize the graphs that Client Manager produces to show just the infor-
mation you need to track a client’s progress. You can also generate and print
a SOAP-format summary of client progress over time. The Session Summary
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2 TUTORIAL

includes all session data and clinician notes. The Session Summary is stored
in a normal word processing format that allows you to edit the information
and print it out for archiving or presentation.

You can also use Client Manager to prepare a summary of client contact. The
Services Summary collects and prints billing and insurance information for
selected date ranges. As with the Session Summary the report is generated
in a format that can be read and edited by any word processor. With Client
Manager you can quickly and easily manage many clients, and always have
access to stored data.

2 Tutorial

2.1 Creating a Client Profile

When you first start Client Manager, you’ll see a log-in screen, as shown in
Figure 1. The log-in screen prevents unauthorized persons from looking at
confidential medical records1.

Figure 1: Log-in Screen

Client Manager, does not require a password but we strongly rec-
ommend that you use one as part of your procedures to comply
with HIPPA and other applicable laws. Client Manager will only show

1You should always keep your computer secure, and never rely on Client Manager’s
security features alone. You should follow good security practices—such as regularly in-
stalling critical software updates—on your entire computer, not just in Client Manager.
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2.1 Creating a Client Profile 2 TUTORIAL

the password box in the login screen after you have set a password. (We will
show you how to set a password in section 2.5.) For now, in order to start
Client Manager, simply click OK. Clicking Cancel will exit Client Manager.

Now you’ll see the main Client Manager screen, as shown in Figure 2. It
consists of a menu bar2, two panels, and a set of buttons for each panel. The
left panel lists all clients, and the right panel lists all sessions recorded for
the currently selected client. The buttons are used to create, edit, or remove
clients and sessions.

Figure 2: Main Screen

The Clients box and Session History box will be empty when you open
Client Manager for the first time. To create your first client profile, click
on the New button under the Clients panel, or use the Client menu option
New Client at the top of the screen. You will now see the main Client
Profile screen. This screen is used to edit and view client information, and
to generate services summaries. The default Client Profile screen is shown
in Figure 3. You may fill out as much or as little client information as you’d
like, as long as a first or last name is provided. (You may wish to assign a
number to a client instead of a first/last name, to protect their privacy.) The
Date-of-Birth field has a default value that you should update. Click the OK
button to create your first client. The main Client Manager screen will now
show your new client in the Clients panel. You can edit a client profile either

2The commands in the menu bar will appear at the top of the screen if you are using
a Macintosh.
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2.1 Creating a Client Profile 2 TUTORIAL

by double-clicking on the client’s name, or by using the Profile button below
the Clients panel.

Figure 3: Client Profile Screen

The main Client Profile screen has tabs for entering additional information
about the client. The Medical Info tab is used to enter the Diagnosis, Prog-
nosis, Referring Physician, and Current Level of Functioning. Drop-down
boxes can be used to quickly enter diagnosis codes and descriptions. Select
the diagnosis code from the drop-down box and the number will appear in
the panel below the box. Click on the Add button to have it added to the
list. If you know the diagnosis code, you can enter it in the box and click the
Add button to have the code and description entered in the box above. You
can add additional comments to the Diagnosis panel by entering them in
the input box below the drop-down box and then clicking the Add button.

If there is a diagnosis that you use frequently and it is not in the drop-down
box, you can add it by using the Edit List button. You can also edit the text
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2.1 Creating a Client Profile 2 TUTORIAL

of an existing diagnosis using this screen.

All of this information will be included when you print the Client Profile and
when you generate a Services Summary page for billing.

The Insurance tab is used to enter insurance information about the client.
This information will print when you print the Client Profile and when you
generate a Services Summary page for billing. Each client may have one or
more insurance policies. Policies are listed by the policyholder’s name and
the insurance company. You can add policies to a client by clicking the Add
Policy button.

To specify the primary insurance policy to use, select the policy, then click
the Use as Default button. That policy will move to the top of the list.
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2.2 Accessing Session Data

2.2.1 Collecting Session Data Automatically

All data recorded in Client Manager is grouped into therapy sessions. You
can immediately start recording data from a game by starting the game from
within Client Manager. Once you have a client setup, select that client, click
Launch Game and the game you want to play3. Client Manager will start
the game, and the client may play through it normally.

Once the client has finished the game, Client Manager will return you to the
login screen. When you log back in, Client Manager will open a new session
window displaying the data recorded from that game. At this point, you may
review the data, enter SOAP notes, or start another game using the session
window’s Launch Game button in the lower-right corner. If you choose to
launch another game, that game’s data will be appended to your session.

Game data that Client Manager has recorded will appear in the upper-right

3If you don’t see the game in the list, see appendix A.1.

Figure 4: Report Window
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corner of the session window. There will be a list of games the client played
during this session. Double-clicking on one of the games will open a report
window giving specific data on the client’s performance.

Figure 4 shows a sample game report from LocuTour Multimedia’s High-
Level Attention software. Most games organize their data in a tabular for-
mat, with columns representing the different types of data collected, and
rows representing individual trials in the game.

2.2.2 Making SOAP Notes Manually

You may, if you wish, track therapy sessions in which the client did not play
games. To create a new therapy session in Client Manager, click the New
button in the Session History box. Client Manager will open a blank session
window (depicted in Figure 5) for the current date and time. At this point,
you may enter your SOAP notes.

SOAP notes are entered in the bottom half of the window. There are four
tabs, for Subjective, Objective, Assessment and Plan notes. In each tab, there
is a space for you to type your notes, as well as a selection of boilerplate notes
you may wish to use.

To include a boilerplate note, click the note. A check mark will appear in the
box next to the note. After you have selected the notes you want, click the
Add to Notes button to append them to your typed notes.

Some boilerplate notes may have blanks, denoted by “ ” or “<placeholder>”.
When you insert your notes, Client Manager will select the first blank so you
can fill it in. Press Tab to move to the next blank, or Shift+Tab to move to
the previous one.

You may also enter general (non-SOAP) notes in the box in the upper-left
corner of the window. If you wish, you may keep these notes private by
turning off the Print Notes checkbox above them.

2.2.3 Creating Session Reports

When you are satisfied with your notes, you can create a printable session
report by clicking the Create Report button in the lower-right corner. This
will create a report that can be edited in your word processor and printed
out. Figure 6 shows a sample summary report.

You can create three types of session report:

Summary This includes only the SOAP notes, and a list of the games the
client played.
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2.3 Graphs 2 TUTORIAL

Full In addition to SOAP notes, this includes all available data on the client’s
performance this session, including all the data recorded from each
game the client played.

Abbreviated This is a shorter version of the full report. Games may choose
to provide less detailed information, if they support it.

2.3 Graphs

As you collect more data from your clients, you may wish to see their progress
over a particular period of time. Client Manager stores data for each game so
that you can easily generate customized graphs for each client. Some Client
Manager–enabled programs may come with pre-defined graphs. You may use
them as is or customize them for each client.

Figure 5: Client Manager Session Log
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2.3 Graphs 2 TUTORIAL

Figure 6: Report: Client Manager Session Log

To view graphs for a particular client, return to the main Client Manager
screen. Click on a client’s name to highlight it then click the Graphs button
below the Session History box. You will see a list of saved graphs (as de-
picted in Figure 7). This list contains pre-defined graphs and graphs that you
created. To create a new graph, click the New Graph button at the bottom
of the window.

Note:
The data in each graph is specific to each client but the graphs
themselves can be shared. Graphs are saved to a central loca-
tion in Client Manager. When you open the graph list for a
client, Client Manager will display only graphs that are rele-
vant to that client.

When you click New Graph, Client Manager will open the Graph Builder
window, as shown in Figure 8. Give your graph a title, and pick a game from
the drop-down list of games the client has played.

By default, Client Manager will use all available data to generate the graph.
If you wish, however, you can choose to use only data collected over a certain
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2.3 Graphs 2 TUTORIAL

Figure 7: List of Graphs

period of time. To do this, click the Show data from radio button, and select
the appropriate dates.

At this point, you may choose the options you wish to use for this graph.
Most Client Manager-enabled games will have a set of options similar to those
shown in Figure 8. Some games may have additional or different options,
depending on the type of data the game collects. The graph title and time
constraints are the only options available for graphs in all games.

The Numeric Columns box shows the variables that have been collected by
the game. You can choose which variable to graph horizontally (the X-axis)
and one or more variables to graph vertically (the Y-axis).

The horizontal axis is set to Date by default. The horizontal axis will show all
of the days in the range that you have selected. In general, graphing by date
gives you a good idea of how the client progressed over time. Alternatively,
you may wish to graph by Trial Number. This view will show progress over
time without the gaps from days when the client did not do the exercise. To
change the horizontal axis from Date to Trial Number, click on Trial Num-
ber in the Numeric Columns box. It will highlight. Then click on the Graph
Horizontally button and Trial Number will now display in the Horizontal
box. Client Manager will let you use any variable in the numeric column you
wish, so you can visualize aspects of your client’s performance. It is up to
you to make sure that the values you choose for the axes make sense.

Choose one or more variables for the vertical axis by either double-clicking
on the variable in the Numeric Columns box or highlighting it and clicking
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Figure 8: The Graph Builder Window

the Graph Vertically button. The variable you selected will be added to the
Vertical list. You can change the ordering of the variables by highlighting
one and then clicking the Move Up and Move Down buttons below the list.

Some Client Manager games may report level information—for example, the
client may have played a game at Easy difficulty one week, and Medium
difficulty the next. If this is the case, you may group the data points on your
graph by selecting a column from the Group data points by drop-down box.
This will cause Client Manager to place data points belonging to different
levels on different lines on the graph. Additionally, each line will have a label
next to it to identify it.

When you are satisfied with the options you have chosen for your graph,
click the Show Graph button. Client Manager will automatically save your
options, and open the graph in a new window, as shown in Figure 9. The
graph type that you have created will be available to use with all of your
clients. If you have made customizations, you may wish to use a detailed
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Figure 9: Graph of Progress

description in the graph title. For example, if you have created a graph for
Stoplight that uses trial number instead of date as the horizontal axis, you
may wish to call it Stoplight - By Trial.

Note:
In the current version of Client Manager you cannot “Save
As” to save a copy of your graph and retain the original graph
settings. If you save a graph with a new name, the graph set-
tings with the original name are overwritten.

You may wish to fine-tune the graph by changing the way the data is pre-
sented for one or more variables. You can make changes to a variable’s title,
color, and labels by using the Edit Axis window, as shown in Figure 10. You
can also add a target line for a variable.

To edit the way the horizontal axis is presented, click the button in the Hor-
izontal box. To edit a variable on the vertical axis, double-click the variable
name in the Vertical box or highlight it and click the Edit button below.
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Figure 10: Edit Axis Window

You can view the raw data and export it to a spreadsheet for further analysis
by clicking on the Data Table button, as shown in Figure 11. You can save
the data by clicking the Save as CSV button. It will be saved in a comma-
delimited format which is readable by most spreadsheet programs.

Figure 11: Raw Data Panel with Save as CSV option

2.4 Services Summary

Services summaries may be generated and sent to insurance companies, either
as a bill or as a progress report on the client’s most recent sessions. You can
generate a services summary in one of two ways:

c© 2005-2010 LocuTour Multimedia, Inc. All rights reserved.
For more information call 800.777.3166 or visit www.locutour.com

13

http://www.locutour.com/
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• In the main Client Manager window, select a client. Then open the
Client menu and select Services Summary.

• Double-click a client in the main window. Click the Services Summary
button in the lower-right corner.

Figure 12: Services Summary

A typical Services Summary window is shown in Figure 12. Unlike other
windows in Client Manager, the Services Summary window does not
allow you to change many of the fields that are displayed. Client
and insurance information must be changed using the Client Profile screen.
Information is shown on this screen for validation purposes. Notes will be
saved for the next time you generate a Service Summary. Changes to CPT
codes, Units, and Charges will be remembered. When you Create Report
all of the information on the screen, plus some additional information, is
captured in a document that can be opened later, edited, and saved.
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For more information call 800.777.3166 or visit www.locutour.com

14

http://www.locutour.com/


2.5 Preferences 2 TUTORIAL

The client’s entire session history will be listed in the table in the bottom
half of the window. Sessions that are to be included in this services summary
will have a check mark next to them under the Show? column. To include a
session in this summary, make sure it is checked. If you want to leave a session
off, clear its check box. The Dates from/to boxes will update automatically
to reflect the range of sessions you have selected.

Rather than check each individual box, you can select a range of sessions
with the Shift key, and click the Show Selected or Hide Selected buttons
to check or uncheck all of them at once.

For each session, you should specify a CPT code, the number of units (hours)
for that session, and a charge per unit. Client Manager will automatically
calculate the total bill and display the total at the bottom.

Finally, you may include all your session notes with your services summary.
To do this, turn on the Include Sessions checkbox and select the type of
session report you want. The different types were explained earlier in section
2.2.3.

When you are finished, click the Create Report button to generate your
services summary. Client Manager will prompt you for a place to save the
summary, and will open it in your preferred word processing program. From
there, you may edit the summary further, or print it.

2.5 Preferences

Return to the main Client Manager screen. Click on the File menu and
select the Preferences option. The Preferences window is where you choose
options and fill out your professional information. The first tab, Settings,
as shown in Figure 13, contains options affecting the operation of Client
Manager.

Figure 13: Settings Tab in Preferences Window
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There are several options available to you:

Log Out on Launch will cause Client Manager to automatically log out
whenever you start playing a game. This is to prevent unattended
clients from closing the game and accessing private medical records.

Date Format allows you to change the way Client Manager displays dates.
This change takes effect everywhere in Client Manager—dates that
appear in lists, in the client profile, and on printable reports will all be
affected. The default is MM-dd-yyyy.

Time Format allows you to change the way Client Manager displays times,
in much the same way you can set the date format. The default is
hh:mm:ss a/p.

List Clients As allows you to specify how clients are listed in the main
window — you can choose to sort them by either first name or last
name.

Change Password resets your password to whatever you type in the box.
If you forget your password, contact us at LocuTour Multimedia using
the contact information on our website4, or call us at 800.777.3166 and
we will help you reset your password.

Figure 14: Professional Information Tab in Preferences Window

Now click on the Professional Information tab, as shown in Figure 14. This
is where you fill in professional information about yourself as a medical care

4www.locutour.com
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provider. There are fields for your name, title, business address, business
phone number, fax number, e-mail address, provider number, tax ID number,
state license number, and a field for your default charge per session. All of
this information will be printed on each Services Summary you print. Note:
The Services Summary uses the information on this screen to calculate the
charge for each client session. If there is no default charge when the session
is started then Client Manager will not calculate a charge for the session.
Similarly, if you change the session charge Client Manager will not change
the charges for sessions before the change was entered.

Now click on the Lists tab, as shown in Figure 15. This tab collects all of
the drop-down boxes in one place for easy editing. You can edit the values
in the drop down boxes for ICD Codes, CPT Codes, and Prognosis.

Figure 15: Edit Lists Tab in Preferences Window

2.6 Help

There are three ways of getting help and information about LocuTour Multi-
media’s Client Manager. First, you may read this manual in printed format.
Second, you may access this manual on your computer by clicking the Help
menu and selecting Help Contents. Third, you may log on to LocuTour Mul-
timedia’s website by opening a browser and visiting www.locutour.com. You
may also access the website directly by clicking the Help menu and selecting
Website.
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2.7 Conclusion

Congratulations! That’s all you need to know to effectively use Client Man-
ager to keep track of your clients. As you collect more data, you will see
how easy it is to manage all that information. The rest of this manual is
dedicated to exploring each Client Manager feature in-depth. If you have
any questions or concerns that are not addressed in this manual, feel free to
contact LocuTour Multimedia via our website, or call us at 800.777.3166.

3 Clients

There are two ways to create Client Profiles. You may click the New button
in the main Client Manager window and fill out a profile window, or you may
launch a game and play it as a guest. Any record returned from a LocuTour
Multimedia game without a corresponding Client Manager client profile will
be placed under a new client named “Guest”. The guest client is stored and
tracked like any other Client Manager client. You can rename the Guest
client later if you wish.

You may rename a client at any time by opening their client profile, chang-
ing the name fields, and clicking OK. This will change that client’s name
everywhere it appears within Client Manager.

You may remove any client by selecting the client’s name in the main Client
Manager window and clicking Remove, or using the Clients menu item Re-
move Client.

Warning:
Client removal is permanent. All information for that client
will be deleted and will not be recoverable. It is probably a
good idea to leave all of your clients in the program for archival
purposes, even if you do not plan to use that profile again.
There is no limit to the number of clients that may be managed
by Client Manager. Storing large numbers of clients will not
slow down Client Manager and takes up very little room on
your hard disk.

You may also remove individual sessions from a client, and individual reports
from a session. These changes are also permanent, and should only be made
if you are sure that you do not want to keep that information.

c© 2005-2010 LocuTour Multimedia, Inc. All rights reserved.
For more information call 800.777.3166 or visit www.locutour.com

18

http://www.locutour.com/


3.1 Advanced: Combining Session Records 3 CLIENTS

3.1 Advanced: Combining Session Records

You may often play multiple games with a client during a therapy session. If
you accidentally start a game from the main Client Manager screen (rather
than the session window), that game’s records will go into a new session
record (and not the session you’re working on). You may wish to combine
(or “merge”) all these session records into one.

To do this, first select all the sessions you wish to combine. You may select
individual sessions by holding the Ctrl key on your keyboard and clicking
each one individually. Or, you can hold down the Shift key to select a range
of sessions.

Once you have selected your sessions, open the Session menu and click Merge
Sessions. All but the first session you selected will be removed, and the first
session will be highlighted. That session now contains all of the data from
the sessions you selected earlier.

3.2 Advanced: Backing Up or Transferring Clients

It is usually a good idea to leave inactive client profiles intact in Client
Manager. You can however, move inactive client profiles to a location where
they will not be read by Client Manager. The same process can be used to
make a backup of client profiles and store them in a safe place (or transfer
them to another computer running Client Manager).

3.2.1 Performing System Backups

On the Mac, Client Manager’s data is stored in UserName ⇒ Library ⇒
Preferences ⇒ LocuTour Multimedia ⇒ Client Manager. Copy this folder
to backup your data or transfer it to another computer.

On Windows its a little more complicated because the data folder is hidden
from non-admin users. It is found at, C: ⇒ Documents and Settings ⇒
User Name ⇒ Application Data ⇒ LocuTour Multimmedia ⇒ Client Manager.

3.2.2 Archiving a Client

To create a backup of a particular client (called a client archive), select the
client in Client Manager. Then open the Client menu and choose Archive
Client. Client Manager will ask you where you want to save the archive.
When you click Save, Client Manager will compress and store all of that
client’s information to the file you specified.
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You may save this file or transfer it to another computer. It contains all
information about that client, including any documents or graphs you might
have saved in the client’s folder.

3.2.3 Restoring a Client

To restore a client, open the Client menu and select Restore Client. Select
the client archive you saved earlier and click Open. Client Manager will
restore the client.

If you already have a client with the same name in Client Manager, Client
Manager will ask if you want to merge the archived client with the client
you already have. If you allow Client Manager to merge, it will add any new
sessions and saved files that are in the archive, but not in Client Manager,
to the already-existing client.

4 Saving

Client Manager automatically saves information whenever you close a data-
entry window. Data collected from other LocuTour Multimedia products is
automatically saved every time you run Client Manager. Generally, clicking
OK in a window will save any changes you have made. If you click Cancel,
or close a window by clicking the close button in its title bar, Client Manager
will ask you if you want to save.

There is a Save option under the File menu that will save everything that
has been changed in Client Manager since the last save. However, this is
rarely necessary since most saving happens automatically.

Warning:
Client Manager depends heavily on its file structure on the
hard drive to operate. Do not move or alter the Client Manager
folder or any of its sub-folders on the hard drive, or Client
Manager may operate unpredictably.

5 Printable Reports

Printable reports can be used to maintain a hard-copy archive of important
information, or provide information to others (such as insurance companies)
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in a physical format. Client Manager can generate several types of printable
reports, including:

• Client profiles (Name, address, insurance information...)

• Services summaries (“Bills”, list of sessions attended, ...)

• Sessions (SOAP Notes, including Full, Summary, and Abbreviated re-
ports)

• Individual game reports (Raw data—Dates, levels, ...)

To generate a printable report, open the relevant window in Client Manager
and click the Create Report button. Client Manager will ask you where to
save the report and save it in Rich Text Format (.rtf). You can then open it
in your favorite word processing program, review, edit, and print the report
from within your word processor.

5.1 Notes

Some windows have a Notes field with a Print Notes checkbox next to
it. If the Print Notes checkbox is checked (as it is by default), the notes
you type there will be included in the printable report. However, if you enter
observations or other private notes, you may uncheck this checkbox to prevent
the notes from being included in any printable reports.

5.2 Session Reports

When saving a printable session report, you have three choices. Your choice
only applies to the data included in the Session Report. It does not affect the
data that is retained by Client Manager. The choices are explained briefly
below:

Full Includes a session summary sheet with a list of games and SOAP notes,
followed by a full printout for each game played during that session.

Summary Includes only the session summary sheet, which has a list of the
games played and the session SOAP notes.

Abbreviated Includes a session summary sheet, followed by a set of ab-
breviated reports (which include just the final results information and
the date for each report). In most cases, abbreviated reports are the
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same as full reports—including the SOAP notes. However, games may
choose to provide additional information on a full report that is not
included in an abbreviated report.

Graphs Graphs are not printed with the session reports. Follow the instruc-
tions in section 2.3 for creating and printing graphs.

A Troubleshooting

A.1 “No Games Installed” appears in the Game menu.

This occurs when Client Manager is not aware of any Client Manager-enabled
games. If you know you have a Client Manager-compatible game installed,
you should inform Client Manager of its existence by doing the following:

1. From the main Client Manager window, select Game ⇒ Search Com-
puter for Games.

2. Client Manager will begin searching your hard disk for compatible
games. When it finds a game, it will display a message informing you
of this.

3. After Client Manager has completed its search, your game should ap-
pear in the Game menu. If it does not, see section A.2.

A.2 My game is not in the Launch Game Menu.

This occurs when Client Manager does not have a game plugin for your game,
or the game has moved or been deleted from the hard drive. There are two
possible solutions, which you should try in the order listed:

1. Reinstall the game. It is possible that some game files were moved or
corrupted.

2. Add the game again to Client Manager.

(a) From the main Client Manager window, select Game ⇒ Add
Game. Client Manager will ask for the location of the game.

(b) Browse to the place where the game is installed. On Windows, it is
usually in a folder that is somewhere inside My Computer ⇒ C:

⇒ Program Files. On the Mac, it is usually in Applications.
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show up as multiple sessions in Client Manager.A TROUBLESHOOTING

(c) Inside the game’s folder, there will be a number of files, only one
of which can be selected. On Windows, this will be a file with a
name ending in .jar. On Mac, this will be the game application
itself. Select that file and click Open.

(d) Client Manager should automatically log out and back in. Check
the Game menu to see if your game appears.

If neither of these two alternatives correct the problem, chances are there is
a problem with Client Manager or the game itself. Please contact LocuTour
Multimedia or the company that produced your game for assistance.

A.3 I played multiple games during a single therapy
session, but they show up as multiple sessions in
Client Manager.

Client Manager can start games in two different ways. Games can be started
from the main window, or from a session window. If you start a game from
the main window, the game will always be recorded in a new session.

To ensure your games get recorded in the correct session, you should always
start games from the session window. Only start games from the main screen
when you know you want the game to be recorded in a new session.

If you have already played multiple games, and want to merge them into a
single session, see section 3.1.

A.4 Clients are missing from the client list.

If an internal or operating system error corrupts Client Manager’s data (such
as moving or deleting any files in Client Manager’s folder on the hard drive),
Client Manager may be unable to display clients. If you have made any
changes to Client Manager’s folder, quit Client Manager and undo those
changes. Then, restart Client Manager and see if the missing clients have
returned. If they have not, contact LocuTour Multimedia for further assis-
tance.

A.5 I forgot my Client Manager password.

Contact LocuTour Multimedia for help in resetting your password. Write
your new password here:
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A.6 Help menu items do not work.

Client Manager uses your default Internet browser to launch its help infor-
mation. If you do not have a default browser, or do not have any browsers
installed, or if your operating system does not provide the location of your
browser to Client Manager (this is often the case in Microsoft Windows 98
and earlier), then Help menu items may not work. All documentation listed
in the Help menu is included on the Client Manager CD, and may also be
accessed through the Start Menu or on the hard drive in Client Manager’s
installed directory.

A.7 Where can I find ICD and CPT codes?

International Classification of Diseases codes can be found at
http://www.cdc.gov/nchs/datawh/ftpserv/ftpicd9/ftpicd9.htm.

CPT codes are harder to find since they are controlled by the AMA. The
ASHA web site has a list of Medicare covered CPT codes in Adobe Acrobat
format at http://www.asha.org/members/issues/reimbursement/medicare/

analysis-2007mfs.htm.

A.8 The tables in the reports I create don’t look right.

If you are using Mac OS 10.3, you will need to use a program other than
TextEdit to view the reports you create. TextEdit on 10.3 and earlier does
not support tables and displays them incorrectly. Use a word processor such
as OpenOffice or Microsoft Word to view and print your reports. OpenOffice
is available freely from http://www.openoffice.org/.

A.9 Other Problems

If you encounter any problems not described in this manual, please contact
LocuTour Multimedia or visit our website at http://www.locutour.com/.
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